PCS 7 Process Visualization on Mobile Devices with RDP
SIMATIC PCS 7 V8.1

Warranty and Liability

Note

The Application Examples are not binding and do not claim to be complete regarding the circuits shown, equipping and any eventuality. The Application Examples do not represent customer-specific solutions. They are only intended to provide support for typical applications. You are responsible for proper operation of the described products. These Application Examples do not relieve you of the responsibility to use safe practices in application, installation, operation and maintenance. When using these Application Examples, you recognize that we cannot be made liable for any damage/claims beyond the liability clause described. We reserve the right to make changes to these Application Examples at any time without prior notice. If there are any deviations between the recommendations provided in these application examples and other Siemens publications – e.g. Catalogs – the contents of the other documents have priority.

We do not accept any liability for the information contained in this document. Any claims against us – based on whatever legal reason – resulting from the use of the examples, information, programs, engineering and performance data etc., described in this Application Example shall be excluded. Such an exclusion shall not apply in the case of mandatory liability, e.g. under the German Product Liability Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of a product, fraudulent concealment of a deficiency or breach of a condition which goes to the root of the contract (“wesentliche Vertragspflichten”). The damages for a breach of a substantial contractual obligation are, however, limited to the foreseeable damage, typical for the type of contract, except in the event of intent or gross negligence or injury to life, body or health. The above provisions do not imply a change of the burden of proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts hereof is prohibited without the express consent of Siemens Industry Sector.

Security Information

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, solutions, machines, equipment and/or networks. They are important components in a holistic industrial security concept. The products and solutions from Siemens undergo continuous development with this factor in mind. Siemens recommends strongly that you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable preventive action (e.g. cell protection concept) and integrate each component into a holistic, state-of-the-art industrial security concept. Third-party products that may be in use should also be considered. For more information about industrial security, visit http://www.siemens.com/industrialsecurity.

To stay informed about product updates as they occur, sign up for a product-specific newsletter. For further information, visit http://support.automation.siemens.com.
# Table of contents

Warranty and Liability ................................................................. 2  
1 Task .......................................................................................... 4  
2 The solution .................................................................................. 5  
  2.1 PCS 7 Process visualization on mobile devices ............................ 5  
  2.2 Hardware and software components required ......................... 6  
  2.3 Validity .................................................................................. 7  
  2.4 Steps ..................................................................................... 7  
3 Resolution and scaling ................................................................. 8  
  3.1 Aspect ratio ........................................................................... 8  
  3.2 Configuring the OS Project Editor ............................................ 9  
  3.3 Configuring the graphics runtime .......................................... 10  
  3.4 Scaling process pictures .......................................................... 11  
  3.5 Publishing changes ............................................................... 14  
4 Initializing remote access ............................................................. 18  
  4.1 Initializing the mobile device ..................................................... 18  
  4.1.1 Installing the remote app ..................................................... 18  
  4.1.2 Initializing the remote app .................................................... 21  
  4.2 Operation ............................................................................... 27  
  4.2.1 Connecting to the Web Client .............................................. 27  
  4.2.2 Mouse cursor functions ...................................................... 28  
  4.2.3 Keyboard functions ........................................................... 31  
  4.2.4 Hiding the menu bar ......................................................... 33  
  4.2.5 Disconnecting ................................................................. 33  
  4.3 Internet Explorer settings ......................................................... 34  
  4.3.1 Setting the target computer as the start page ....................... 34  
  4.3.2 Setting full screen .............................................................. 36  
  4.3.3 Using the plugin function .................................................... 37  
  4.3.4 Process control on the mobile device ................................. 38  
5 References .................................................................................... 39  
6 History ......................................................................................... 39
The process visualization is an essential part of a system. The larger and more complex a system is, the more information must be processed and visualized. Stationary operating stations are localized over Ethernet cables and are matched to the visualization of specific subsystems. The central control room together with its process operating stations is located far away from the sensors and actuators. To increase flexibility, there is a requirement to be able to move freely with a mobile operating device within the system and close to the process-proximate components.
2 The solution

2.1 PCS 7 Process visualization on mobile devices

The use of mobile devices suggests itself as a way of obtaining process-proximity to all information. Thanks to their handiness, weight and computing power, smartphones and tablets offer the best prerequisites for convenient and process-proximate operator control of the system. At present there is no standardized app for smartphones or tablets to connect them directly to a system. However, numerous apps are available that can establish a remote connection to a terminal server, which in turn is connected to the system. When using mobile devices, the scaling of the process pictures may have to be adapted to the respective resolution. The Application Example will help you achieve the best possible display results.
2.2 Hardware and software components required

An OS client with "PCS 7 Web Server" software installed provides OS server information over the Internet. This is implemented via the PCS 7 Web Option. The type of hardware and software components required can be found in the following handbook: "SIMATIC Process Control System PCS 7 Web Option for OS (V8.1)" section 5 "Hardware and software requirements"


This document deals only with the representation and scaling of the process pictures as well as the setup of the remote connection between the mobile devices and the Web Client.

Web Client

An OS client with "Web Client" software installed serves as the interface between the mobile devices and the Web Server.

Remote Desktop Protocol

Communication between the mobile devices and the Web Client takes place via the Remote Desktop Protocol.

Internet Explorer is opened via the Web Client. Via plugins you receive graphical information over Internet Explorer while the Web Client server provides the computing power. This allows you to control and monitor process pictures and obtain complete process control.

Mobile devices

The mobile devices must meet the minimum requirements of the remote app. It's up to you to decide which model you use. In this case, the larger the screen, the clearer and easier the process pictures are displayed. A smartphone with a 5-inch screen size is enough for pure monitoring purposes and is more portable than a tablet with a 10-inch screen size. If you place more emphasis on controlling process objects or want a better overview of the process pictures, a larger model (from 7 inches upwards) is recommended.

Note

Please ensure that certified mobile devices are used, if the example is applied in explosion hazard zones.
Remote app

To enable remote access, there are various apps available from different providers for Android, iOS and Windows Phone. Some apps, like RealVNC, require additional software on the desired target computer and a commercial license, while others are based on the Remote Desktop Protocol but are available free of charge. The remote app “2X RDP Client” has been used for this Application Example.

This provides the following advantages:

• Free of charge
• No separate software is needed on the target computer because "2X RDP Client" is based on Microsoft's already existing "Remote Desktop" operating system function and its RDP (Remote Desktop Protocol).
• Easy and clear operation
• Available for:
  - Android smartphones (from V1.5), Android tablets (from V3.0)
  - From iOS 3.1.3 for Apple iPad, iPhone and iPod Touch
  - Windows Phone 8 and higher

Note
Further information about the remote app can be obtained from the manufacturer's website.
http://www.2x.com/de/rdp-client/devices/

2.3 Validity

This Application Example is valid for SIMATIC PCS 7 V8.1 and WinCC V7.3.

2.4 Steps

<table>
<thead>
<tr>
<th>No.</th>
<th>Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Configure OS server and WinCC project.</td>
</tr>
<tr>
<td>3.</td>
<td>Install and configure the remote app on the mobile device (section 4.1).</td>
</tr>
<tr>
<td>4.</td>
<td>Connect the mobile device to the Web Client (section 4.2).</td>
</tr>
</tbody>
</table>
3 Resolution and scaling

3.1 Aspect ratio

Process pictures are scaled linearly. Devices with an aspect ratio of 4:3 will not display correctly or will be distorted if your monitor resolution corresponds with an aspect ratio of 16:9. This also applies the other way around. The following illustration shows this problem:

For this reason it is recommended to use a mobile device having the same display ratio as that of the monitor.

**Note**

Pay attention to the display ratio when purchasing the mobile device/monitor.

To calculate the aspect ratio, divide the horizontal pixel width by the vertical pixel width.

**Example:**

\[
\frac{1920 \times 1080}{1080} = \frac{1920}{9} = 16 \frac{4}{3}
\]

\[
\frac{1024 \times 768}{768} = \frac{1024}{3} = 4 \frac{2}{3}
\]
3.2 Configuring the OS Project Editor

Procedure

1. Right-click on "OS Project Editor" in WinCC Explorer.
2. Click "Open" in the context menu. The "OS Project Editor" dialog box opens.
3. Choose the screen resolution that applies to your monitor in the "Layout" tab.
4. Click on the "Apply" button to apply the change.
3.3 Configuring the graphics runtime

Procedure

1. Click on "Computer" using the left mouse button. A list with the configured computer name appears in the right pane.
2. Right-click on the configured computer name in the list.
3. Click the "Properties" button in the context menu. The "Computer properties" dialog opens.
4. Switch to the "Graphics runtime" tab. Select the "Adjust picture" radio button in the window attributes and confirm the change with "OK".
3.4 Scaling process pictures

Procedure

1. In WinCC Explorer, left-click on "Graphics Designer". A list with the available process pictures appears in the right pane.

2. Open the process picture "@screen.pdl" by double clicking or right-clicking on "Open picture(s)".

3. Select the picture window "@win12" from the drop-down list.

4. Click on "Other" in the object properties of the picture window.

5. Change the values of the attributes "Scroll bar" and "Adapt window" by double clicking on "no" and the value of the attribute "Adapt picture" by double clicking on "yes".

Note: Note the value of the attributes, as the changes must be reversed again at a later stage.
6. Open the process picture "@1001.PDL" by double clicking or right-clicking on "Open picture(s)".

7. Select the picture window "@Desk" from the drop-down list.
8. Click on "Other" in the object properties of the picture window.

9. Change the values of the attributes "Scroll bar" and "Adapt window" by double clicking on "no" and the value of the attribute "Adapt picture" by double clicking on "yes".

10. In the Graphics Designer, run "File> Save All" to save the changes in both process pictures and exit the Graphics Designer.
3.5 Publishing changes

Procedure

1. Open the Web View Publisher in WinCC Explorer
   Right-click > "Web View Publisher".

2. This dialog window "WinCC Web Publishing Wizard" opens:
   Click on the "Next >" button
3. Select the file "@1001.pdl" and click the ">" button to add it to the list of selected files.

4. Repeat step 3 with the file "@screen.pdl" and click the "Next >" button.
CAUTION If you have not yet published all process pictures in this way, click the ">>" button to add all process pictures to the list of selected files.

5. If the list of selected files contains functions, click on the "<<" button to remove them.

6. Click on the "Next >" button.

CAUTION If you have not yet published all functions in this way, click the ">>" button to add all functions to the list of selected files.

7. If the list of selected files contains referenced graphics, click on the "<<" button to remove them.

8. Click on the "Next >" button.

CAUTION If you have not yet published all referenced graphics in this way, click the ">>" button to add all referenced graphics to the list of selected files.

9. Click on the "Finish" button to publish all files.
10. When the process is completed, another dialog box opens. Click the "OK" button, and then exit the WinCC Web Publishing Wizard.

11. Repeat all steps in section 3.4 and reverse the changes made to the object properties of the process pictures.

Note: This procedure is necessary because the changes will affect only the published process pictures and not the OS station.

12. Activate the OS runtime.
4 Initializing remote access

Requirements

- Web Server and Web Client are configured.
- The OS runtime is enabled.

Note
For more information about installing and configuring the Web Server and Web Client, please refer to "Process Control System PCS 7 Web Option for OS (V8.1)" via the following link:

4.1 Initializing the mobile device

The following illustrations were recorded with a Nexus 5 and Android v4.4. The display and operation using other versions of Android and other operating systems, like iOS and Windows Phone, may vary slightly. The functionality is retained.

4.1.1 Installing the remote app

Procedure

1. Open, according to the operating system:

<table>
<thead>
<tr>
<th>Android</th>
<th>iOS</th>
<th>Windows Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Google Play Store]</td>
<td>[App Store]</td>
<td>[Windows Store]</td>
</tr>
</tbody>
</table>

2. Open the Search window. This is generally represented by a magnifying glass icon.

[Search window illustration]
4. Initialize remote access

3. Enter "2X RDP client" in the search and confirm your entry to start the search.

4. Tap the app shown above called "2X Client RDP" to learn more about the app and install it.

5. Tap on "INSTALL" to download the app and install it.

6. The progress of the installation is displayed on your screen.
Note

Some apps may require particular permissions to have, for example, access to the network. Tap on "Accept" to grant these rights to the app.

To download and install apps you require a valid account. You may be requested to enter your password before downloading.
4 Initializing remote access

4.1.2 Initializing the remote app

To enable access to your Web Client via "Microsoft Remote Desktop", you first of all have to adjust some settings within the remote app.

Procedure

1. Tap the "2X Client" remote app icon to start it.

2. To establish a remote connection, tap either on "Add connection" or the small plus icon.

3. Select "Standard RDP" as the connection type.

4. Click the relative button to edit the information.
5. Under "Alias", enter the connection name and confirm your entry.

**Note**

This connection appears later in the list of possible connections, with the name specified here.

The connection name is optional.
6. Under "Server", enter the name or IP address of the Web Client and confirm your entry.

7. Under "Port", enter the port number and confirm your entry.

Note
The port number of the firewall on the target computer is set to 3389 by default. If this port number changed, add the changed port number over here.

8. Under "User name", enter the name of the required Windows user and confirm your entry.
4 Initializing remote access

9. Then, tap on "Connection" to get to the other options.

![Connection]

- Alias
  Color_gs

- Server
  172.16.75.10

Secondary Server

- Port
  3389

- User Name
  Admin

- Password

- Connection Mode

10. Tap on "Display" to get to the display options.

![Display]

- Properties
- Connection
- Display
- Local Resources
- Experience
- Network
- Authentication
- Advanced
11. Tap on "Layout".

12. Select "Landscape".

13. Tap on "Resolution".
14. Select the resolution you have selected for the OS server in the previous step, in the OS Project Editor.

![Resolution screen]

**Note**
If your mobile device has a lower resolution, you can still select a high resolution. The resolution you select here refers to the virtual screen that the Windows operating system shows you when you connect via RDP.

15. Tap on "Back" to complete the setup.
4 Initializing remote access

4.2 Operation

4.2.1 Connecting to the Web Client

Tap the name of the established connection to connect to the Web Client.

Tap the three vertically aligned dots to view more options and to edit the connection settings.
4.2.2 Mouse cursor functions

The remote app supports touch screen operation. This allows you to left-click with a single tap. You can display a mouse cursor and mouse buttons via the menu bar.

Moving the mouse cursor

You can move the cursor by pulling and holding the middle mouse button.
4 Initializing remote access

**Left-click**

To perform a left-click, tap with a finger on the desired area on the screen. Alternatively, you can use the on-screen mouse button by moving the cursor over the desired area and tapping the left mouse button.

**Right-click**

To perform a right-click, tap with one finger on the desired area on the screen, then tap with another finger anywhere else on the screen. Alternatively, you can use the on-screen mouse button by moving the mouse cursor over the desired area and tapping the right-hand mouse button.

**Scrolling**

Tap and hold two fingers on the area you want to scroll, and move your fingers in the desired direction.
4 Initializing remote access

Zooming

Tap and hold two fingers on the area you want to zoom, and move your fingers away from each other to zoom into the area. Move your fingers towards each other to zoom out of the area.
4.2.3 Keyboard functions

To show or hide the keyboard, tap on the keyboard icon in the menu bar.

Numeric keypad

To show numbers and other symbols, tap on the button with the three dots and then on the "&123" button.
Num keyboard
To display the depicted buttons, tap on the button with the three dots and then on the "Num" button.

Fn keyboard
To display F buttons (Function buttons) and other symbols, tap on the button with the three dots and then on the "Fn" button.
4.2.4 Hiding the menu bar

To use the entire surface of your touch screen, you can hide the top menu bar. When you hide the menu bar you get the message saying that the menu bar can be shown again by swiping it down with three fingers.

4.2.5 Disconnecting

To log off the user and disconnect, proceed as if you were using a normal Windows computer. Click on Start and log off. Alternatively, you can disconnect from the menu bar.
4.3 Internet Explorer settings

Note
You can find out how to configure the expanded security for Internet Explorer in section 9.3 in the handbook "Process Control System PCS 7 Web Option (V8.1)" via the following link: http://support.automation.siemens.com/WW/view/en/90682846

4.3.1 Setting the target computer as the start page

It is laborious to have to enter the name or IP address of the Web Server in the URL field each time you open Internet Explorer. We recommend setting the address of the Web Server as the start page.

Procedure

1. Open Internet Explorer.

Note
To get a faster access to Internet Explorer, we recommend that you create a shortcut on the desktop or to add a link to Internet Explorer on the task bar.

2. Click on "Tools (Settings) > Internet options".
3. Enter the name or IP address of the Web Server in the "Start page" input field.

4. Click on the "Apply" button.
4.3.2 Setting full screen

The URL, Search, Favorites bar, etc, take space unnecessarily on the screen. To make use of the complete screen size, they should be hidden.

Procedure

1. Open Internet Explorer.

2. First of all click on "Tools > Full screen (F11)". This hides superfluous toolbars and the address bar of Internet Explorer.
4.3.3 Using the plugin function

The Web Navigator provides plugins for Internet Explorer, which are necessary to be able to operate and monitor display blocks in process pictures.

Preparation

How you install the plugins is explained in the handbook "SIMATIC Process Control System PCS 7 Web Option for OS (V8.1)" in section 9.5 "How to install the plugins", available via the following link:

You are logged on to your Web Client and have connected yourself via Internet Explorer to the Web Server.

Procedure

1. Move the mouse cursor to the left edge of the screen to display the options bar of the Web Navigator.
2. Click on "Settings" on the options bar.
3. Click on "Web Client properties" to open the properties of the WinCC Web Navigator client.
4. Select the "Adjust size" radio button in the "Process pictures" area.
5. By clicking on the "Process pictures" link (below in the settings), you will be redirected to the process pictures.
4.3.4 Process control on the mobile device

Requirement

- Connection to the Web Client is established with the aid of the remote app
- Plugins are installed (see section 4.3.3).

Procedure

1. Start Internet Explorer.

2. Enter your Web Server address or IP address in the input field "Address".

3. Enter your **WinCC user name** and **password** in the dialog box "Enter network password". If you want to save your password, activate the "Remember password" option button.

Note

You can obtain further information on process control from the handbook "Simatic Process Control System PCS 7 Web Option for OS (V8.1)" in section 9.6 "How to start process control on the Web Client" via the following link: [http://support.automation.siemens.com/WW/view/en/90682846](http://support.automation.siemens.com/WW/view/en/90682846)
5 References

Table 5-1

<table>
<thead>
<tr>
<th>Topic</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Siemens Industry Online Support</td>
<td><a href="http://support.automation.siemens.com">http://support.automation.siemens.com</a></td>
</tr>
<tr>
<td>Download page for this entry</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/102843424">https://support.industry.siemens.com/cs/ww/en/view/102843424</a></td>
</tr>
<tr>
<td>OS Project Editor</td>
<td><a href="http://support.automation.siemens.com/WW/view/en/102768374">http://support.automation.siemens.com/WW/view/en/102768374</a></td>
</tr>
</tbody>
</table>

6 History

Table 6-1

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>12/2014</td>
<td>First edition</td>
</tr>
<tr>
<td>V1.1</td>
<td>04/2016</td>
<td>Text adjustments</td>
</tr>
</tbody>
</table>